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The Pentaho Bl Platform is a Web-based framework that leverages elements of Pentaho Analysis and Pentaho
Reporting to provide easy-to-use tools for creating and sharing Pentaho Analyzer reports, ad hoc reports, and
dashboards. It is the heart of the Bl Suite, which also includes powerful software to prepare your data and create
detailed reports.

The BI Platform Enterprise Edition includes two graphical user interfaces: The Pentaho User Console, which helps you
discover patterns, trends, and other hidden information about your data; and the Pentaho Enterprise Console, which
gives sysadmins, IT managers, CIOs, and database administrators fine-grained control over every aspect of Bl Platform
configuration, management, and security.

The purpose of this guide is to teach business users how to use the Pentaho User Console. The instructions below
assume that the Bl Platform has been properly configured for users, roles, and data sources through the Pentaho
Enterprise Console.
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First Steps

Your system administrator, IT manager, or supervisor should have provided you with a Web address and login
credentials for the Pentaho User Console. If not, now is the time to inquire about them.

How to Log Into the Pentaho User Console

Follow these steps to log into the Pentaho User Console:

1. Open a Web browser and type in the address of the Pentaho server.
You'll see an introductory screen with a Login button in the middle.
2. Click Login.
A login-related pop-up appears.
3. Type your user name and password in the appropriate fields and click Login.

You are now logged into the Pentaho User Console, and ready to start creating and running reports and Pentaho
Analyzer reports.

® Pental'io '

open sounce business intelligence

Welcome to the Pe | 4,

User Name:
lioe

The Pentaho User Console
powerful Business Intellig
found in the Pentaho Bl 5§ Password:
to your reports, analysis ¥ [sessssss

™ Launch in new window

Login  Cancel

Navigating the Pentaho User Console

The Pentaho User Console was designed to be intuitive to users accustomed to standard file managers like Windows
Explorer, and Web browsers like Firefox.

The first thing you will see when logging in is the quick launch, shown below:

6 | Pentaho BI Suite Official Documentation | First Steps
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Browse $
E5 Steel Wheels Click Toggle to enable and
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Note: If you do not have a Pentaho Dashboards Enterprise Edition entitlement, the New Dashboard button will
| instead be Manage Content, which will open a dialog box that offers quick availability to the edit, share, and
schedule functions for existing content.

Click one of the three icons in the center of the screen to create a new ad hoc report, Pentaho Analyzer report, or
dashboard.

The button bar near the top of the page also contains icons for starting new ad hoc reports, Pentaho Analyzer reports,
and dashboards, along with a button to print the current report or Pentaho Analyzer report, and to open a previously
saved solution.

The menu above the button bar performs these same functions, plus administrative actions if you are logged in as an
administrator, and also offers access to My Workspace and external links to help and support resources.

The three buttons on the quick launch page appear when you log onto the Pentaho User Console for the first time, and
when you close all tabs in the solution browser.

You can change views between My Workspace and the solution browser at any time by clicking the rightmost icons in
the top button bar, or through the View menu.

The navigation pane on the left allows you to browse through your existing solution folders. Solutions are content files
such as dashboards and reports inside the folder. You can create and delete solution folders by right-clicking inside
the navigation pane. You can also examine information associated with solution folder contents by right-clicking and
selecting Properties.

Creating a New Solution Folder

Follow the instructions below to create a new solution folder in which to save solution (content) files such as
dashboards, ad hoc, and analyzer reports.

1. |
Click L. (Toggle Browser) so that you can see navigation pane (Browse) on the left.
2. Scroll down to the end of the list of solution folders and right-click to display the New Folder dialog box.

Note: If you want to create a sub-folder inside an existing solution folder, right-click on the existing folder and
| select New Folder.

3. Inthe New Folder dialog box, type a name for your folder and click OK.

Note: The repository is refreshed. This action may take a moment.

Pentaho BI Suite Official Documentation | First Steps | 7



The new folder appears in the navigation pane.

Follow the instructions below to delete a solution folder.

1. -
Click LI (Toggle Browser) so that you can see navigation pane (Browse) on the left.

2. Scroll down to the solution folder you want to delete, right-click, and select Delete.
You will be asked to confirm your delete request.

3. Click OK.

Note: The repository is refreshed. This action may take a moment.

The folder disappears from the navigation pane.

My Workspace is a graphical overview of the reports and Pentaho Analyzer reports you've created and scheduled. Click
the triangle on the left side of each category to see the elements it contains.

Reports that you've created or have access to will have options to the right of each report listing to suspend or run
them, and schedules have options to suspend, run, or delete them.

Waiting
This category lists all private schedules that will run in the future. Clicking Cancel will delete the schedule. If you want to
suspend a schedule, you should use the Suspend function of the My Schedules list instead.

Complete

Each report that has been run via a schedule will show up in this list. Every time the schedule executes, it overwrites
that report's previous entry in the Complete list.

My Schedules

This category contains a comprehensive list of your private schedules, including those that are not currently waiting to
run. This will be identical to your Waiting list unless you have suspended any of your schedules.

All Schedules
This is a combined list of public and private schedules under your control. It is only viewable by administrator-level
users.

Public Schedules

This is a list of all public schedules set by the administrator from the Pentaho Enterprise Console. You can run a public
schedule manually, but you cannot change its interval through the Pentaho User Console.

8 | Pentaho BI Suite Official Documentation | First Steps



The Data Sources feature allows you to connect to your data quickly so that the data can be used to create reports,
(such as ad hoc reports, dashboards, and analyzer reports), in the Pentaho User Console. For example, when CSV
data is uploaded to the Pentaho Bl Server metadata models are automatically generated for each data source. The
models can be further customized to adjust field names, formatting, aggregation types, and dimensional hierarchies (for
Pentaho Analysis).

If you are running a test environment, you can quickly add, edit, and delete a relational or CSV data source in the
Pentaho User Console using the Data Source wizard. You can restrict access to a data source by individual user

or user role; by default, authenticated users are limited to view-only permissions. (See "Assigning Data Source
Permissions for the Pentaho User Console" in the Pentaho Security Guide for more information.) This means that they
are limited to selecting a data source from a list of available options.

Note: Non-administrative users of the Pentaho User Console do not see icons or buttons associated with
adding, editing, or deleting a data source. They are also not allowed to create a data source.

When selecting a relational data source, users can query against the data source within the scope of data defined
in query you set up. If users choose a CSV-based data source, data is loaded from the CSV file and staged on the
Pentaho Bl Server.

The Data Source Wizard, which allows you to set up access to a relational data source or CSV data source in the
Pentaho User Console, is available in the following instances:

* When you click the New Data Source button on the Pentaho User Console Quick Launch page
« When you select File -> New -> Data Sources in the Pentaho User Console menu bar

When you select File -> Manage -> Data Sources from the Pentaho User Console menu bar and click v (Add)
e When you click Add in the Select a Data Source step in Ad Hoc Reports
* When you click Create Data in charts in the Dashboard

When you click w (Add) as a first step of the create Data Table process
* When you click Create New Data Source when creating a new Analyzer report

Using Pentaho Metadata Editor

In a production environment, users of the Pentaho User Console get access to data for creating ad hoc reports and
building dashboards from metadata models provided by an administrator. Using Pentaho Metadata Editor (PME), you
can restrict what data a user can access down to a table, column, or row. This type of security fine-tuning, and many
other capabilities, are not provided by the Data Sources feature. The default metadata models created when adding
new data sources in the Pentaho must be opened in Pentaho Metadata Editor for further customization.

For more information, refer to the Pentaho Metadata Editor Guide available in the Pentaho Knowledge Base.

Before you can connect to a data source in any Pentaho server or client tool, you must first install the appropriate
database driver. Your database administrator, CIO, or IT manager should be able to provide you with the proper driver
JAR. If not, you can download a JDBC driver JAR file from your database vendor or driver developer's Web site. Once
you have the JAR, follow the instructions below to copy it to the driver directories for all of the Bl Suite components that
need to connect to this data source.

Note: Microsoft SQL Server users frequently use an alternative, non-vendor-supported driver called JTDS. If
you are adding an MSSQL data source, ensure that you are installing the correct driver.

Backing up old drivers

You must also ensure that there are no other versions of the same vendor's JDBC driver installed in these directories.
If there are, you may have to back them up and remove them to avoid confusion and potential class loading problems.
This is of particular concern when you are installing a driver JAR for a data source that is the same database type

as your Pentaho solution repository. If you have any doubts as to how to proceed, contact your Pentaho support
representative for guidance.

Pentaho Bl Suite Official Documentation | Adding a Data Source in the Pentaho User Console | 9



Installing JDBC drivers

Copy the driver JAR file to the following directories, depending on which servers and client tools you are using
(Dashboard Designer, ad hoc reporting, and Analyzer are all part of the Bl Server):

Note: For the DI Server: before copying a new JDBC driver, ensure that there is not a different version of the
same JAR in the destination directory. If there is, you must remove the old JAR to avoid version conflicts.

« Bl Server: / pent aho/ server/ bi server-ee/tontat/|ib/

« Enterprise Console: / pent aho/ server/enterprise-consol e/ j dbc/

- Data Integration Server: / pent aho/ server/ dat a-i ntegrati on-server/tontat/webapps/ pent aho-di/
VEEB- | NF/ | i b/

« Data Integration client: / pent aho/ desi gn-t ool s/ dat a-i ntegration/li bext/JDBC/

* Report Designer: / pent aho/ desi gn-t ool s/ report -desi gner/1ib/jdbc/

» Schema Workbench: / pent aho/ desi gn-t ool s/ schema- wor kbench/ dri vers/

e Aggregation Designer: / pent aho/ desi gn-t ool s/ agg- desi gner/dri vers/

» Metadata Editor: / pent aho/ desi gn-t ool s/ net adat a- edi tor/1i bext/ JDBC

Note: To establish a data source in the Pentaho Enterprise Console, you must install the driver in both the
| Enterprise Console and the Bl Server or Data Integration Server. If you are just adding a data source through
the Pentaho User Console, you do not need to install the driver to Enterprise Console.

Restarting

Once the driver JAR is in place, you must restart the server or client tool that you added it to.

Connecting to a Microsoft SQL Server using Integrated or Windows Authentication

The JDBC driver supports Type 2 integrated authentication on Windows operating systems through the
integratedSecurity connection string property. To use integrated authentication, copy the sqljdbc_auth.dll file to all
the directories to which you copied the JDBC files.

The sqljdbc_auth.dll files are installed in the following location:

<installation directory>\sqgljdbc_<versi on>\ <l anguage>\ aut h\

Note: Use the sqljdbc_auth.dll file, in the x86 folder, if you are running a 32-bit Java Virtual Machine (JVM)

| even if the operating system is version x64. Use the sqljdbc_auth.dll file in the x64 folder, if you are running a
64-bit JVM on a x64 processor. Use the sqljdbc_auth.dll file in the 1A64 folder, you are running a 64-bit JVM on
an Itanium processor.

Follow the instructions below to create a relational data source. In addition to allowing you to connect to your database
(using JDBC), you must also enter a SQL statement that defines the "scope, "(similar to a database view), of your data
source.

Note: In the context of the Pentaho User console, a relational "data source" is a combination of a connection
| plus a query. Pentaho recommends that you use the Pentaho Metadata Editor to create relational data sources
for a production environment.

You can customize how columns are presented to users who are building queries against the new data source; for
example, you can define "friendly" column names and select options that define how data is aggregated (sum, min.,
max., etc.), and more.

Once you create the data source, it is available to users of the Dashboard Designer, Chart Designer, and Ad Hoc
Report.

You must be logged on to the Pentaho User Console as an administrator to follow the instructions below. Additionally,
your database must be up and running in order for you to complete the steps required in the Data Source Wizard.

1. Inthe Data Source Wizard, type a name for the new data source in the Data Source Name field.

Note: The name of the data source is important because it becomes the name of the data source displayed
| in Analyzer, Ad Hoc Report, and Chart Designer.

10 | Pentaho BI Suite Official Documentation | Adding a Data Source in the Pentaho User Console



2.

Under Source Type, select Database as your data source type.

3. [y
If not already configured, click "' (Add) to add a connection to the database that contains the content you want to

U

o

oo

access. The Database Connection dialog box appears.

Database Connection

General Connection Name:
Cplons SampleData
Database Type: Setiings
MySOL Haost Mame:
s . lacalh
Generic database oralhost
Database Mame:
sampledata
Port Numiber:

2001

Adding Databases 8 || jear pame:
ALCESS:

Matve (JDBC)

pantaha_user
Password:

Test

QK Cancel

Note: If this is the first time you are using the wizard, you will not see a list of connections under Available
| Connections. When you have added your connection, the connection name will appear in the list. Click the
Adding Databases hyperlink if you need help connecting to your database.

In the Connection Name text box, enter an easy-to-remember name that identifies the data you are accessing.

Select a Database Type from the list.

Text fields for required settings associated with your connection type appear under Settings on the right. See
Adding a JDBC Driver if the driver you need is not listed.

. Enter the appropriate connection information for your database type.

Consult the list of JDBC class names for more information.

In the Connection dialog box, click Test to test your connection and click OK.
A success message appears if your settings are correct. The connection name appears in the list.

. Under SQL Query, enter your SQL Query. Click Preview to ensure that your query returns data.

—r
¥

Data Source Wizard

= Source Data Source Name
SampleData
Source Type ]
Database v

Connection A OB S0OL Query

mannas_sampie selase * from COSTCMERS
SampleData

xwmﬂ“‘vvdmw/m/

b,

9. Click Close to exit the Preview window.
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10.Click Finish.
In the background, after you click Finish, a default metadata model is generated based on the query for use in
Analyzer, Ad Hoc Reporting, Report Designer, and Chart Designer. See Editing a Data Source Connection for
instructions about changing connection details.

Creating a CSV Data Source in the Pentaho User Console

Follow the instructions below to create a CSV-based data source. For testing purposes, you can save an Excel
spreadsheet as a CSV file.

In the Data Source Wizard, type a name that identifies your new data source in the Data Source Name field.
Under Source Type select CSV from the list to define a CSV file as your data source and click Next.
Click Import to open the Import File dialog box.

Click Browse to search for your CSV file; click Import when you locate the file.
The Import File dialog box closes and the CSV file is uploaded to the Bl Server. You can click Cancel, if necessary,
and select different file.

P wbdpE

Note: Notice that a preview of the contents of your file appears in the lower portion of the wizard page. If
items are not aligning correctly, it is because you must specify your delimiter and enclosure types. Go on to
the next step.

5. Specify the delimiter and enclosure types. Enable First row is header if the first row of your CSV file is a heading
for columns in the file.

Data Source Wizard
Data Source Name
marina test
Staging Settings | Source Type

CE V|

= Source

File
Import...

Hote: CSV data will be [oaded into a staging table

(| Delimiter:)

LN 2Ny A

(® Comma ) Semicolon (%) Double Quaots
O Tab ) Space ) Single Quots
C ather 2 Heone
L] First row is header
Fle Preview
PRESIDENT FROM TO ORDER PARTY TERMS VICE I:'F-'hE\""gr
George Washington 1789 1797 1 none 2 John Ad:
John Adams 1797 1801 2 federalist 1 Thomas g
Thomas Jefferson 1801 1809 3 democratic-republican 2 Aaron B}
James Madison 1809 1817 4 democratic-republican 2 George g
James Monroe 1817 1825 5 democratic-republican 2 paniel 3
b
5
2

Wwwad

Important: You must make selections under Delimiter and Enclosure for the Metadata table to build
correctly. In the example line, 1, 4, 5,02/ 12/ 77, " Stri ng Val ue" the commas are delimiters and the
quotation marks around "String Value" is the enclosure.

The File Preview window displays the first few lines of your CSV file based on the selections you made for
specifying the delimiter, enclosure, and header. Once the columns align correctly in the preview you will know that
the delimiter and enclosure have been set correctly.

6. Click Next to display more details about the columns in your source file and to edit staging-related settings.
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Note: Notice that all columns are enabled in this step. Click Deselect All to disable all columns. You can
| then select the columns that require formatting individually. Click Select All to enable all columns again, if
necessary.

7. If applicable, change the Name and Type values. Use the drop-down list to display format options for dates and
numeric values. Formats are auto-detected based on the contents of your data source; however, if you see a format
option that is not correct, enter it manually in the appropriate Source Format text box.

Note: Refer to Sample Date Formats for additional help formatting dates. Refer to Decimal Formats for
| additional help formatting humbers.

Length indicates the maximum number of characters allowed in a field. Precision is the number of digits after a
decimal point. Drop-down lists are not enabled for certain data types such as the String data type.

Data Source Wizard ‘{f
Source Select the columns you want to stage on the Pentaho Bl Server and configure their attributes ',_,5&}"
Source Format to specify how numenc or date fields are formatted in the source CSV file ‘:
= Staging Settings =
Available Columns ‘ﬁ?
Mame Type Source Format Length Precision
| ORDERNUMBER | STRING ~]| |13 0
[+ CUANTITYORDERELSNUMERIC ﬂ = a
\| F | |PRICEEACH NUMERIC ] e 7 2 |
_ —— = & da2 00 *
@ ORDERLINENUMBEF| NUMERIC v [ g 4 a \‘J)
—r— — o i)
= ||sALES STRING 2 [ v 3 0 7
¥ | ORDERDATE STRING ] BAROE |[22 0 \}!
r
F |STATUS STRING ~] |15 0 £
=
@ |[QTR_D NUMERIC ] ~| 3 0 jr
F | MONTH_ID NUMERIC ~] ~| 4 o _,,>
i : b
E |YEAR_ID STRING ~] || 12 0 i
P BEOOLC T IRE =01 e uI (IRETY il
Show File Conte
—

mewwvaﬂw‘
Important: Boolean values are rendered as "true" or "false.”

8. Click Show File Contents to see a sample of the data in your source file. Click OK to return to staging and make
changes if necessary.

9. Click Finish when you have completed your configuration and formatting tasks.
A success message appears indicating the number of rows being loaded into the database and that a default
metadata model was created. Enable Keep default model to use the default model or click Customize model now
to customize the model.

The data in your CSV file is extracted and staged temporarily in a database table. Your new data source is now
available to users. To refine the data and make it more accessible to users of reports, dashboards, and data tables, you
must use the Data Source Modeler. See Editing a Data Source in the Pentaho User Console.

Increasing the CSV File Upload Limit
Follow the instructions below if you need to increase the size of the upload limit associated with CSV files.
1. Goto...\biserver-ee\pentaho-sol uti ons\ syst emand open the pentaho.xml file

2. Edit the XML as needed; (sizes are measured in bytes):

<fil e-upl oad- def aul t s>
<rel ati ve-pat h>/ syst em net adat a/ csvfil es/</rel ati ve-pat h>
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<I-- max-file-limt is the mximumfile size, in bytes, to allow to be upl oaded
to the server -->
<max-file-1inmt>10000000</ max-file-limt>

<I-- max-folder-limt is the maxi mum conbi ned size of all files in the upload
folder, in bytes. -->
<mex-f ol der-1im t>500000000</ max-fol der-limt>

</fil e-upl oad- def aul t s>
3. Save your changes to the file.
4. In the Pentaho User Console, go to Tools -> Refresh System Settings to ensure that the change is implemented.

Changing the Staging Database

Hibernate is the default staging database for CSV files. Follow the instructions below if you want to change the staging
database.

1. Goto...\biserver-ee\pentaho-sol uti ons\syst enl dat a- access and open settings.xml.
2. Edit the settings.xml file as needed. The default value is shown in the sample below.

<I-- settings for Agile Data Access -->
<dat a- access- st agi ng-j ndi >Hi ber nat e</ dat a- access- st agi ng-j ndi >

Note: This value can be a JNDI name or the name of a Pentaho Database Connection.

3. Save your changes to the settings.xml file.
4. Restart the Pentaho User Console.

Where Models are Stored
All generated models are stored in the following location, \ pent aho- sol ut i ons\ adm n\r esour ces\ net adat a.

Important: Pentaho recommends that you do not change the location where models are stored.

Using the Modeler to Edit a Data Source

You can edit a data source in Ad Hoc Reports, Pentaho Analyzer, and in the Dashboard. If you are editing a data
source while using Ad Hoc Reports, select the data source you want to edit from the list of available data sources and

click Edit. If you are creating a chart or data table, select the data source you want to edit from the list and click f

(Edit). If you have created an Analyzer report, click j (Edit) in the upper right corner next to Available Fields. You
can also edit a data source by navigating to File -> Manage -> Data Sources in the Pentaho User Console menu bar
and opening the Select Data Source dialog box.

Select a Data Source Salact Data Source
Aralabie

Hadabie
Hisman REsources
Iroventory

Crders

q Note: If you want to edit the connection information, see Editing a Data Source Connection in the Pentaho User
Console.
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When you edit a data source you are using the Data Source Modeler. The modeler allows you to design reporting and
OLAP metadata models on the fly. The modeler also allows you to refine and organize your data so that it is more
accessible to report users. For example, you can change the field display names, set an aggregation type, and change

formatting,

Follow the instructions below to edit a data source:

1. In the Data Source Modeler, examine your data.

Datasource Madeler ‘}
5
Data 5 Model Properties }‘
-
$EE s -0 Source Column >-
BIRTHDATE :
A = B2 Measures =ROM 3
ORDER & EROM ' [L
PARTY FROM
PRESIDENT b ORDER 5
SALARY 4
o W SALARY Detais 3
VICE PRESIDENT . TERMS Display Name 2
FROM i
B TO Aggregation \H:)
1 Dimensions S’IJI" - e )
Qnm =
s 14 BIRTHDATE NONE i
3 1 FROM {‘J
= 1 ORDER ;’}
el
@ 14 PARTY >
# 14 PRESIDENT }
.. |om— y

Measures are humeric values such as sales price, cost, and profit. Dimensions are the context that allow users to
understand the significance of the measures. For a sales database, the dimensions could include Product, Store,
Salesperson and so on. In other words, users can examine the sales figures by store, by product, and by sales.

Dimensions can have one or more hierarchies (!-'é!-); (hierarchies are not shown in the example). Hierarchies are
levels that organize data into a logical structure. Click (+) next to fields under Measures and Hierarchies to display
their contents. Moving up and down between the levels of a hierarchy is called drilling.

You can also edit the source data to define the properties of your CSV file or re-enter a SQL query. In the example
above, the FROM, TO, TERMS, and ORDER fields must be redefined as string types, not numeric. The only
applicable measure in this example, is SALARY. Unnecessary fields can be removed clicking ﬁ (Delete) in the
modeler toolbar.

You can also move a field under Measures or Dimensions by clicking and dragging the field into its appropriate
location. A green check mark indicates that you can place your field without error.

Note: Click B8 (Clear Model, in the upper right corner) to clear the existing model and start over.
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|[BIRTHDATE o ORDER
FROM
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PARTY 5
PRESIDEMN o TERMS N
SALARY
TERMS B TO
I:::: PRESIDENT = 9 Dimensions o
# 14 BIRTHDATE
= 14 ORDER
@ 14 PARTY r
s 1 PRESIDENT ?‘
# 14 SALARY H
® 14 TERMS :
wFROM E
@ Y TO £
1{,}

# 14 VICE PRESIDENT

P e il

2. If you have clicked Edit Source in the modeler to make changes to a SQL query or CSV flat file (delimiter,
enclosure, or header), click Finish to update the metadata table.

If you disable columns that were previously enabled, a prompt appears in the modeler indicating that the data has
been deleted. You must adjust the data in the modeler before proceeding.

3. Click OK to update the data source.

The updated data source is now available to users.

Editing a Data Source Connection in the Pentaho User Console

Follow the instructions below to edit a data source connection in the Pentaho User Console:

1. Inthe New Data Source dialog box, under Connection, select the connection you want to edit.

2.
Click &
The Database Connection dialog box appears.

3. Update the connection information as needed. You can click Test to make sure your connection is working correctly.
4. Click OK to exit the Database Connection dialog box.

Deleting a Data Source Connection in the Pentaho User Console

Follow the instructions below to delete a data source connection associated with the Pentaho User Console.

Important: If you delete a data source connection, all reports, charts, and other content users have created
using the connection will no longer render.

1. Under Connection in the New Data Source dialog box, select the connection you want to delete.

Click ﬁ (Delete).
A warning dialog box appears.

3. Click OK to delete the connection.
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If you have administrative permissions, you can delete data sources associated with ad hoc reports and dashboards in
the Pentaho User Console.

Important: When you delete a data source all reports or charts that end-users have created based on that data
source will no longer render. Deleting a data source also deletes the model associated with that data source.

The delete Data Source option is available in the following instances:

When you select a data source and click ﬁ (Delete) when in the Select Data Source dialog box available from
File -> Manage -> Data Sources
* When you select a data source and click Delete in the Select Data Source step in Ad Hoc Reports

When you select a data source and click ﬁ (Delete) when creating a chart

When you select a data source and click ﬁ (Delete) when creating a data table
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The procedures below explain everything you need to know about working with ad hoc reports in the Pentaho User
Console.

Note: The ordering of all of the list elements in the ad hoc reporting interface is determined by the data source's
| metadata, which is created and modified through Pentaho Metadata Editor.

Pentaho Report Designer is the most comprehensive report design tool in the Pentaho Bl Suite Enterprise Edition, but
for preliminary report exploration or to generate a report quickly use the ad hoc report wizard built into the platform. Ad
hoc reporting helps you quickly identify and group interesting and relevant data, apply constraints to it, and generate a
report. The resulting reports are viewable through the built-in preview feature; through a Pentaho Reporting-based Web
application; or as a standalone PDF, XLS, CSV, or HTML file. To create an ad hoc report, follow these steps:

1. Inthe File menu, select the New sub-menu, then click Report.
The ad hoc reporting wizard appears in a new solution browser tab.

2. In the first step of the wizard, select a Data Source. The Details table will populate with available tables and
columns.

Data Sources are defined by your administrator.

3. Inthe Apply a Template field, select a predefined report template. A thumbnail preview of the template will appear
in the Template Details field.

A template specifies a variety of properties in the report that affect its appearance, like font size and background
colors for various report elements.

4. Click Next.

5. In the Available Items list, select the business columns that you want to see in your report, and click and drag them
to the Groups, Details, or Filters lists on the right. You must have at least one business column in the Details list for
a report to be valid.

You can select multiple items by holding down the Ctrl key. If you want to delete an item, click the X in the upper
right corner of the field the item is in; if you need to move an item up or down in the list or to other groups, click the
up or down arrows at the top of the Groups list.

6. In the Preview as drop-down box, select a preview format, then click Go. When the preview appears in a new
browser window or tab, verify that it contains the data you selected and that it's presented appropriately.

7. Click Next when you're ready to start refining your report.
8. Click the Level 1 item in the Groups list. The General options list will appear on the right.
9. Modify the level options to your preference.

By default, the Show Group Summary checkbox is selected; uncheck it if you do not want to see group summary
information. The default name for the group summary uses the group name as a variable; you can change this if
you like. The options in the Formatting lists determine where in the report the information in the selected level will
appear.

10.Repeat the above two procedures for other levels that you configured earlier.
11.Click the first item in the Details field. Three new options lists will appear on the right.
12.In the Formatting field, select the numerical formatting and alignment options appropriate for your situation.

13.In the Calculation list, select the function you want to use to refine the element you selected. For instance if you
selected a Business Column that contains product prices, clicking on Sum would add all of the prices together.

14.Click Add a Constraint. The field will expand to show the name of the element, a conditional drop-down box, a text
field, and a checkbox.

15.Select a conditional symbol from the drop-down box, then type in a value in the text box.

This specifies the exact constraint you are applying to the element, meaning that you are decreasing the amount of
detail by adding a higher level of specificity.

16.Add further constraints as necessary by clicking Add a Constraint again. Remove a constraint by clicking its
checkbox and then clicking the X at the top of the list.
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If there is more than one constraint in the list, you will have the option of adding conditional operators for the
constraints via a drop-down box to the left of each item in the list, meaning you can specify AND or OR conditionals
on each constraint.

17.In the Sort Columns field, click Add to specify how each element in the Details list should be sorted, then select the
sort order from the drop-down box.

18.Repeat the above steps for any other items in the Details list.
19.Click the first item in the Filters list. The Constraints list will appear on the right.
20.Add constraints as necessary, per the above instructions for adding constraints to items in the Filters list.

For string-type Business Columns, you will have the option of searching the database tables that apply to the
column. When this option is available, it is accessible via a magnifying glass icon to the right of the text box.

21.Repeat the above instructions for additional filters.
22.Click Next to move on to the next screen.
23.To set the header, footer, description, paper type, and page orientation, change the values accordingly.

PDF is the only output type that has a concept of a page, so the Page portion of the Header and Footer sections
only applies to PDFs.

24.Click either the Save or Save As hutton to save your report, or select Save from the File menu. In the ensuing
file dialog, navigate to the location you want to save the report to, type in a filename for the report, and click the
checkboxes next to the file formats you want to save in.

You can continue to modify your report after it's been saved; just click the Save button to update the saved report
after you've made changes.

Note: The Save dialog does not list output types; instead, it pulls the currently selected preview output type.
| By default that is HTML, so that will also be the default format to save as. If you want to save as a different
output type, select it from the Preview drop-down list before saving.

You now have a complete ad hoc report in the format or formats you specified.

After you've created and saved a report, you can go back to it later and change its properties.

1. In the upper left pane, navigate to the location of your report. It should appear in the lower left list when you've
selected the proper directory.

2. In the lower left pane, right-click the report you want to edit, then click Edit in the popup menu.

The ad hoc report wizard will open in a new tab.

After you've created and saved a report, you can delete it using the Explorer-like Pentaho User Console file browser.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to eliminate, then click Delete in the popup menu.

The selected report will be removed from your computer. Any associated artifacts will not be removed, so some manual
cleanup may be required if you want to remove more than just the report.

After you've created and saved a report, you can execute it manually at any time.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to run, then click Run in the context menu.
You can alternatively double-click on a report to run it.
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3. In the Run sub-menu, select one of the following options: New Tab, New Browser Window, or Background.

The options will open the report in a new tab, a new browser window (which may open in a new browser tab,
depending on which Web browser you are using and how it is configured), or it will run in the background and inform
you when the report is ready to view. The popup dialogue that informs you of the report's completion will ask you if
and where you would like to display it.

The selected report will be executed, and display according to the option you selected.
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Pentaho Analyzer is an interactive analysis tool that provides you with a rich drag-and-drop user interface, which makes
it easy for you to create reports based on your exploration of your data. You can also display Pentaho Analyzer reports
in a dashboard. Unlike standard reports which tend to be static or minimally interactive after they are created, Pentaho
Analyzer reports allow you to explore your data dynamically and to drill down into the data to discover previously hidden
details. Pentaho Analyzer presents data multi-dimensionally and lets you select what dimensions and measures you
want to explore. Use the Analyzer to drill, slice, dice, pivot, filter, chart data and to create calculated fields. Users of
Analyzer reports can query the data in a database without having to understand how the database is structured.

Note: The field view in the sample report below is organized by Category (hierarchies and levels within a

| dimension). You can organize the field view in your Analyzer report alphabetically (A-Z), by Number (measures)
- Text (names, categories, etc.) - Time (months, quarters, and years), and by Schema, which displays the
dimensions as defined in the Mondrian schema.

FeidiLat Show Fiters Shovn FeiclLavout .
e Fieic Lt Show Fiter hore P Lavo Mare aailabie Seids (14) for %)
StealWheekSales
& Top 5 Product Lines by Territory g Viewss: |5 ||, Find:
o Oy Cale
i 1Fierinuse AL | Lo | Chear Cache wyf Your repert i ready, Rowe: 20 Columres: 9 " Customers a _
Customer (] umber - Tkl - Tise
S T Harkets 5.
o = Teritor
o hems
Tarfitory Salkes Quantity Unit Saies Saieg Qua -
State Frovince
. ‘:" _' = * Humbers
=21
N i ' * Order Status
APAL Total 341,400 3,496 98 £558.057 Tvoe Fields
APAC Sum $341,400 3,496 598 5558,057 * Product
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vintage Cars 8 Veridor
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EMEA Sum 41,480,021 14,359 £103 42,118,443

Classic Cars

In this exercise, you will be creating a report that displays the actual versus budgeted expenses by region for each
department in the fictitious Steel Wheels company (SampleData).

Follow the instructions below to start creating the Analyzer report.

1. In the Pentaho User Console menubar, go to File -> New and select Analyzer Report.
Pentaho Analyzer opens.
2. Select your Schema and Cube from the list. For the purposes of this exercise, select SampleData:Quadrant
Analysis.
Note: The list of available schemas and cubes are provided by your administrator. A schema is the structure
| of the relational database and includes tables, fields, views, and more. A cube is a data structure that allows
information in a database to be analyzed quickly and from multiple perspectives.
3. Inthe list of fields (on the right), click and drag Department to the Analyzer workspace in the left pane.
The Department column appears in the workspace.
4. In the list of fields, click and drag Budget to the Analyzer workspace in the left pane.
The Budget column appears in the workspace.
5. Right-click the Budget column to display the Edit Column dialog box. Select Column Name and Format ->
Currency ($) from the Format list so that your values display as dollar amounts. Click OK.
6. In the list of fields, click and drag Actual to the Analyzer workspace in the left pane.
The Actual column appears in the workspace.
7. Right-click the Actual column to display the Edit Column dialog box. Select Column Name and Format ->
Currency ($) from the Format list so that your values display as dollar amounts. Click OK.

8. Click and drag the Region column to the report. (Read the note below.)
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Note: Notice that the Region column appears in the workspace; however, you want this column to be the
| first column in the report.

g siid
9. In the workspace, click and drag the Region column to the left of the Department column.

Pentaho Analyzer is designed to provide you with great flexibility when designing the visual structure of your report.

10.At this point you have a functioning report and you can view your data in chart form. Click = (Switch to Chart
Format) to examine your report data in a chart format. The default display is a bar chart but if you click = (Choose
Chart Type) you can select a different chart type to display your data.

11'Save your report before continuing the exercise. In the Pentaho User Console, click IB(Save As). When the Save

As dialog box appears, save your report as Regional Expense Report under/ St eel \Weel s/ Anal ysi s and
click OK.

Simple Conditional Formatting of Measures

Conditional formatting in the Analyzer data grid means that cells will be physically affected by the data they contain.
The most common form of conditional formatting is stoplight reporting, where cell backgrounds are colored red, green,
or yellow depending on user-defined thresholds. Analyzer offers some simple pre-defined methods of conditionally
formatting numeric data. Follow the directions below to implement conditional cell formatting.

1. Right-click a measure in the grid, then select Conditional Formatting from the context menu.
A sub-menu with conditional formatting types will appear.
2. Select your preferred number format from the list.
Consult Conditional Formatting Types on page 22 for more information on simple conditional formatting types.

The analyzer report will refresh and apply the formatting choice you specified.

Conditional Formatting Types

Indicator Type Description

Color scale The background cell color will be
shaded according to the value of the
cell relative to the highest and lowest
recorded values in that measure.
There are several color progressions to
choose from.

Data bar The cell background is partially filled
with a solid color proportional to the
scale of the cell's value relative to the
highest and lowest recorded values in
that measure.
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Indicator Type Description
Trend arrow [An upward or downward arrow is
displayed to the right of the cell value
depending on whether it contains a
positive or negative value.

You have created a working Analyzer report; however you can make the data in the report more useful if you can show
the difference, in dollar amounts, between the actual and budgeted expenses.

Follow the instructions below to enhance your report.

In the Pentaho User Console menubar, go to File -> Open.
Browse to / St eel \heel s/ Anal ysi s and select Regional Expense Report.
Click '© (Switch to Table Format) if you are in chart mode when the report appears.

Right-click the Actual column and select User Defined Number -> Calculated Number.
The New Calculated Number dialog box appears.

5. In the Name field, type Difference.

A wDdhPRE

This step creates a new column in the report.
6. Select Currency ($) from the Format list so that the data in your report displays as dollar amounts.
7. In the right pane of the dialog box, click -l so that a minus sign appears next to [Actual]-.

8. Click Budget in the left pane and click @ to move it to the right pane so that you create a formula that subtracts the
budgeted expenses from the actual expenses, [Actual]-[Budget]. Click OK.
The Difference column appears in the report.

9. Right-click the Region column and select Show Subtotals.
The subtotals for each region is displayed in the report.

10.Save the report.

Filters are used to restrict or limit the data that is presented in a report. For example, a report shows sales by product
line. A filter on Quarter restricts the data so that sales for the fourth quarter in 2006 only are shown. If you were to
add a regional filter of Europe, the report displays data pertaining to European sales in the fourth quarter of 2006,
exclusively. If you were to add a filter on the Product Line field to exclude Surfing, the report displays data pertaining
to European sales in the fourth quarter of 2006 that are not in the surfing product line, exclusively.

Follow the steps below to add a filter to your sample report:

1. Open the Regional Expense Report.

2. Under the report name click Show/Hide Filters next to No Filter in Use.
A workspace for filters appears at the top of the report.

3. Click and drag the Region field/column into the filter workspace.
The Filter on Region dialog box appears. Notice that the values, (Central, Eastern, Southern, and Western),
associated with the Region field are listed in the dialog box. You can choose one of these values or you can enable
Match a specific string to filter the report on a specific string of data.

4. Select Eastern from the list of values and click @ (Add Selected) to move it into the right pane.
Eastern appears with a green checkmark next to it in the right pane.

5. Select Western from the list of values and click @ (Add Selected) to move it into the right pane.
Western appears with a green checkmark next to it in the right pane.

6. Click OK to exit the dialog box.
Your sample report displays data for the Eastern and Western regions only.

Note: You can click Undo or Reset to return to the previous version of the report.

7. Click OK and save your report.

Pentaho Bl Suite Official Documentation | Creating a New Analyzer Report | 23



You must be logged into the Pentaho User Console, and have an Analyzer report open for editing in order to continue.

Follow the below procedure to parameterize your MDX query in Analyzer.

1. Right-click on the dimension member you want to create a parameter for, and select Filter from the context menu.

2. Select the level you want to set as the default parameter value, then click the right arrow to move it to the list on the
right.

3. Click the checkbox at the bottom of the window, then type in a name for the parameter in the Parameter Name field.
4. Click OK.

Your parameter is now created as a filter in Pentaho Analyzer. Whenever this Analyzer report is run, users will have a
selection of columns to filter by.

Note: If you create a dashboard with this Analyzer report, then this filter can be used by Dashboard Designer as
a parameter as well.

Pentaho Analyzer allows you to export your report as a PDF, a Microsoft Excel spreadsheet, or a CSV file.

Follow the instructions below to export your report:

1. In the Pentaho Analyzer toolbar, click More and select Export Report.
The export options list appears.

2. Select Export to PDF.
A PDF of the report appears.

3. Examine your report.

Notice that Pentaho Analyzer appends metadata about the report itself in the PDF. Information about the report
author, the location of the source file, fields used, filter summary, are included.

If a dimension has a number in parenthesis next to it in the field list, that means that it has member properties
associated with it. To constrain a dimension by controlling its member properties, follow the instructions below.

1. Open the field layout by clicking Show Field Layout button above the grid.

Depending on how you have them oriented, you will see your selected dimensions in either the Row Labels or Col
Headers fields.

2. Right-click on a dimension in the row label or column header fields, then select Show Properties from the context
menu.

A sub-menu with all available member properties will appear.
3. Check or un-check the member property boxes to add or remove them from the report, then click OK.

The analyzer report will refresh and show the filter choices you've selected.

To create reports based on specific number value data, you can implement drill-down links in Pentaho Analyzer. This
will turn all non-calculated number fields into links which, when clicked, bring up a configurable data grid that enables
you to quickly view more details for that data point without having to reconfigure your report. Follow the directions below
to turn on drill-linking.

Note: Calculated members are unavailable for drill-down at this time.
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Note: Drill-down links will not work in reports that have filters that are not being used. If you have any filters in
an Analyzer report, they must be used in the report in order to view drill-down links.

1. Open the Analyzer report that you want to add drill links to.
2. Go to the More menu in the upper right corner of the report, and select Set Report Options from it.
3. Select the Show drillthrough links on Number cells checkbox, then click OK.
The number fields in your report will turn into links.
4. Click on a drill-down link to see a data grid that shows all of the available details for that value.

5. To add or remove columns from the grid, click on the down arrow on the right side of any column and select the
Columns sub-menu. From there you can select which columns you want to appear. You can also sort by ascending
or descending values for any column through this menu.

You now have drill-down links for numeric, non-calculated members.

When you disable the Auto Refresh Report feature in Analyzer you can design your report layout first, including
calculations and filtering, without querying the database until you are done. Once the report layout is complete, you can
re-enable Auto Refresh Report. Data retrieval will occur once and your report will display the requested data.

Follow the instructions below to disable auto refresh and build a report.

1. In the Pentaho User Console menubar, go to File -> New and select Analyzer Report.
Pentaho Analyzer opens.

2. Select your Data Source, (schema and cube), from the list.
3. Disable Auto Refresh Report.

q Note: Auto Refresh Report is enabled by default.

Select Data Source

Specify which data source you want to analyze. Each data source consists of a schema and
a cube in the schema. This will determine which fields you will have available. 1)

Create New D38 Source

SampleData: Quadrant Analyss

o

4. Click OK.
The Analyzer workspace appears.

5. To begin creating your report layout, select a field and drag it to the Field Layout area at the top of the workspace.

Note: If you are not seeing the Field Layout area, click the Show Field Layout button.

|

1
& Unsaved Report g View As: o _%
o Mo Filter i use i | ag | Car Cache §
Row Labels Twrhary ¥ \J;
Col Headers wns e ;
Burmbsers Sl Qasmeiiiby <:
Raport -.‘Irf'nltu:" Halhnlr modified. Click Refresh in : run the report ar ok | to enable auto refresh " :a

Ty g it b g S vy - S ‘\..,.\‘,_,ﬁ st
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A message appears when you place the first field allowing you to refresh the report or to re-enable Auto Refresh.
Right-click menus are available for each of the fields you have dragged to the field layout area. You can continue

to build your report and only query the database when the layout is complete. You will build your report in the field
layout area exclusively while Auto Refresh is disabled. The icons next to Row Labels, Col (Column) Headers, and
Numbers indicate the position of the fields once they are placed in the report. Also, a color indicator (yellow or blue)
allows you to differentiate between the field types. Notice that the Analyzer workspace is disabled (greyed out) if you
are not in live query mode.

Row Labels Terrhany )
Col Headers Lra TR £
3,
Fiusmbeers lawn ety
. 4
Raport defisbon has been modified. Click Refresh | , bk here bo enable suto re‘l_\
e l["I.’
- %
o .0 P
" a2 q‘\
:;
- g
al T C
= n
O Unsaved Report G)wm A (] .%
i Ho R use L | Lo e %
oo Labesls Tarrizry 1 Jr'
Col Hesiders L= sane j
Numbers e Juett 3
Report defintion hag been modified. Click Refresh to re-run the report or dick here to enable suto refresh. Refresh
i _,-w-ﬂ-"‘—"\.-u—‘_,_,_r""‘"“"'r\.—.m-.r
i Note: Click the enable/disable Auto Refresh button (\“ %)) in the toolbar to toggle between the two modes.

6. When your report is complete, click Refresh in the pink band of the field layout area. Alternatively, use the toggle
button.

The Analyzer report updates based on the report definition and displays the results. You can continue to edit the report
as needed and click Refresh to run the query again.

Row Labels Tairtery
Coll Headers et g
Humirers mar JearEy arc Ear
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Creating Hyperlinks to Pentaho Solution Repository Content

This feature allows you to create hyperlinks in an Analyzer report that will link to content in the Pentaho Solution
Repository.

The instructions below show you how to create hyperlinks to content inside your Pentaho Solution Repository (reports,
action sequences, etc.). You must adjust the instructions to work with your own data.
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1. Create a simple Analyzer report.
2. Select a row label or column header, right-click, and choose Hyperlink.

k|
003 04 2008 3
@ Eales Sakes Sakes s
Classic Ca it 107 1,838,275 738, 718 1
Motorcydh g che p 220 550, 530 754,325 j"
Planes a% £25,928 200,074 F
Shipe 221 375,672 128, 178
Trains Hyparink, . 302 24,750 #4917
Trucks am 430 £31,976 201,875
VintageC,k 945 927, 550 353, 7:6 ?
op 10, &
P P
3
1
|

Note: In the example above, Line is a row label and Years is a column header. Under these, are the
| individual members that belong to that field/level (for example, Classic Cars, Motorcycles, and so on are
members of Line).

The Link on (Name of Field Level) appears.
3. Click Enable Link to activate the hyperlink feature.

You are not creating a hyperlink to the field header itself but rather to the members under the field level. You can
disable linking at any time by clearing the Enable Link checkbox.

4. Click the down arrow next to Link to and choose Pentaho Repository File.

5. If you choose Pentaho Repository File, you can link to a report (.prpt), an action sequence, or any other file inside
the Pentaho Solution Repository which contains a parameter that can be associated with the content in your
Analyzer report. Click Browse to locate your file in the Pentaho Repository. When you have found the file click
Open.

The Link on Field Name dialog box appears. If a destination parameter that matches the field name in your
Analyzer Report is found, field name is associated to that parameter. Click the checkbox next to the destination
parameter name to enable it.

Limk on Line _‘}
J
Shigw @ hyperlink on Line values that opens a Peniaho Repository File or URL. To dynamically subsbiute lht‘g
current Lins valus nio & parameter or URL, use the siring: {Line} %
B F
=] Enable Link -
Link Ta: Fentahs Repasitory File Eﬁ
-
S
Fie: 4
Ciestration Paramsisr Vaus to Lise -!3'
(&) 3
Lng

If there are more parameters available for linking in the report or other content, they are also listed. You can override
the values to the available parameters or leave them as is. You can also define how hyperlink content will display
(Open in New Tab, Window, Current Window). Finally, you can enter a tool tip that displays when users hover over
the hyperlinks.

6. Click OK.

Hyperlinks appear in your Analyzer report. Click on the links to make sure the content associated with them appears
correctly.
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7. Save your Analyzer Report.

Creating Hyperlinks to a URL
This feature allows you to create hyperlinks in an Analyzer report that will link to a URL for system to system linking, for
example.

The instructions below show you how to create hyperlinks to a URL. You must adjust the instructions to work with your
own data.

1. Create a simple Analyzer report.

2. Select a row label (or column), right-click, and choose Hyperlink. In the example below, Line is row label and Years
is a column header. Under these, are the individual members that belong to that field/level; for example, Classic
Cars, Motorcycles, and so on are members of Line.

=)

2003 2004 2005

Sales Sales Sales
Clasgc Cars 1,514,407 1,838 27% 733,738
Motorcydes . 397220 580,530 286,325
Hanes 347,758 528 528 200,074
2%4,E21 375,672 123,17
72,802 124, 750 36,017
Trugks and Buses . 420,430 531,976 20LEBFS
Vintage Cars 679,940 9%7, 560 3B83,.71B

= |
-J"J\,f“u#’f,\\\rw..\.u‘f\\# \,/

~d_g WHN‘“MWMP \n—/_"&/)

The Link on (Name of Field ) appears.

3. Click Enable Link to activate the hyperlink feature.
You are not creating a hyperlink to the field header itself but rather to the members under the field. You can disable
linking at any time by clearing the Enable Link checkbox.

4. Click the down arrow next to Link to and choose URL.
The Link on Field Name appears.

5. Enter the URL path. You must use the {FieldNamelnsideCurlyBraces} format to pass a parameter in your URL as
shown in the example below where {Years} is the parameter:

htt p: // ww. googl e. conl sear ch?quer y={ Year s}

You can also define how hyperlink content will display (Open in New Tab, Window, Current Window). Finally, you
can enter a tool tip that displays when users hover over the hyperlinks.
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6. Click OK to return to your report.
Hyperlinks appear in your Analyzer report. Click on the links to make sure the content associated with them appears

correctly.
Years k’ 4
ik 2004 pabi]
Line Sales Sales Sales |
Classic Cars 1,514,407 1,638,275 733,733 |
Mprboroy k- ] 230,580 286,325
Plares 347,755 52E,928 200,074
Ships 244,821 ITEET2 128,178
Trains 72,302 124,750 36,917
Trucks and Buses 420,430 531,976 201,875 ;
Viritage Car 79,949 37,580 333,715
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Dashboard Designer enables you to create dashboards that provide users with immediate access to business-related
information they need. Using Dashboard Designer you can customize dashboards to address the needs of different
types of users. For example, your sales staff may want see current leads, while your support staff may want to see a list
of open issues. You can create dashboard pages that address the needs of both user groups.

Creating a dashboard is as simple as selecting a layout, theme, and the content you want to display. This content can
include reports, charts, data tables, URLs, and even interactive Pentaho Analyzer reports. Dashboard Designer also
provides you with the ability to add dynamic filter controls making it easy for dashboard consumers to filter the entire
contents of their dashboard using a simple pick list.

The Dashboard Designer allows you to display the following content types in your dashboard:

« Chart — When selected, opens the Chart Designer that allows you to create bar, line, area, pie, and dial charts for
display in your dashboard.
- Data Table — When selected, allows you to display database-related content in tabular format.

« File — When selected, opens the Pentaho Solution browser that allows you to locate an existing file, such as a
report or chart that you can display in your dashboard.

 URL — When selected, opens a dialog box that allows you to enter the URL of the Web site you want to display in
your dashboard.

To display the content types in the Pentaho User Console, click &= (Insert) in one of the panels in the dashboard.
If you are displaying a chart or data table you must first connect to the data source that contains data you want
displayed.

Content Linking

Content Linking provides you with a flexible way of creating interactivity between content inside your dashboard panels.
For example, it allows users to click on a slice of a pie chart in one dashboard panel and have their action filter the
content in other dashboard panel. For more information about content linking, see Linking to Content in a Dashboard.

You must be logged into the Pentaho User Console. Follow the instructions below to create a new dashboard:

1. In the Pentaho User Console quick launch bar, click New Dashboard. Alternatively, you can click File > New >
i
Dashboard or click £2 (New Dashboard) in the tool bar. The New Dashboard page appears.

2. In the edit pane (lower portion of the page), click Properties, and enter a title for your dashboard page in the Page
Title text box.
The name you entered appears on the top left corner of the dashboard. This name helps you identify the page if you
want to edit, copy, or delete it later.

3. Click Templates to select a dashboard layout.
A blank dashboard with the layout you selected appears.

4. Click Theme to select a theme for your dashboard.
The theme you selected is applied to your dashboard.

The Chart Designer allows you to create bar, pie, line, dial, and area charts that can be added to a dashboard. Below
are the general steps associated with creating a chart:

Select a data source.

Build a query.

Set the data definitions: values, series, category.
Select a chart type and theme.

Enter labels for the chart title, and x,y axes.

If applicable, adjust scaling and label rotation.

o0k wNpE
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7. Place your chart in the dashboard.
8. Save your dashboard.

If you are new to charting, here are some minimal guidelines that may help you determine what type of chart is best
suited for the data you want to present in your dashboard:

Bar Charts

If you want to compare items during a specific time period, consider using a bar chart. Key words to think about when
creating a bar chart are compare or rank. For example if you want to compare items sold to show which one made

the most profit, you might create a bar chart that ranks the products from the lowest to highest profit. The bar's length
determines its ranking; the label identifies the item. Bar chart data can be presented horizontally or vertically depending
on your requirements.

Pie Charts

If you are comparing parts of a whole, consider using a pie chart. Key words associated with charts include, portion,
share, and percentage. If for example, you want to demonstrate the proportion of the company's budget spent on health
insurance, use a pie chart. To make the chart easier to read limit the number of slices to five. Pie charts can also be
exploded, which means certain slices are pulled away from the remainder of the chart for emphasis.
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Line Charts

Line charts are useful for showing changes over time. Key words associated with data that is best suited for a line chart
are trend, growth, and decline. If, for example, you want to show how product sales have changed over five years, use
a line chart. The slope of the line helps users quickly identify the direction of the trend.

Pentaho Bl Suite Official Documentation | Displaying Data in a Dashboard | 31



Dial Charts

Dial charts are often associated with Key Performance Indicators (KPIs). Dial charts are circular and contain a scale,
a needle, and one or more a dial sectors. The dial sector is used to identify a specified area on a dial chart using

a particular color. For example, you could have a dial plotting inventory with a minimum dial value of 10000 and a
maximum dial value of 50000. There could be a red dial sector for the region between 2000 and 4000 indicating that if
the needle is in this area, there is a danger of a supply inventory shortage.

Area Charts

Area charts can be used to show a comparison of the same thing during different points in time. Area charts are
not designed to provide exact data but they do give users visual clues of the relative sizes of the items they are
representing.

Adding Data to Your Chart

Before you can start creating a chart you must select a data source that contains the data you want to use. You must
then define the data that will be displayed in the chart.

Note: If you are unsure what chart type is best for displaying your data, see Choosing the Correct Chart Type
for more information.

Follow the instructions below to add data to your chart:

1. In the Dashboard, choose a dashboard panel and click &= (Insert) and select Chart.
The Select a Data Source dialog box appears.

2. Select the data source from the list of available choices. The data source contains the content you want to display in
your chart.

The Query Editor appears.

3. The Query Editor allows you to retrieve dynamic data from a database for display in a chart. Defining your query is
the first step in ensuring that the correct data is selected. In the Query Editor, click (+) next to a category hame to
display its associated table columns.

4. Click the small yellow arrow to place the column name under Selected Columns. In the example below, the
Customernumber column has been selected and moved under Selected Columns. Notice that the column names
appear under Selected Columns. Continue adding columns as needed.
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5. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions. In the example below, the search is limited to customer numbers.

Query Editor

Categories / Columns Selected Columns
k.omat:nasmamﬂ 'Aggregarion e

Mmernarm
CRUEIOMSENENIS |NONE »| Customernumber
Customernumb

& Orders
Order Number sum ~] Total
Order Date
Required Date
Shipped Date
Status

> |none ~]| Status

Conditions = o @

7 [Combine Agaregation | Column [comparison | Value [Detautt |
NONE  v] Customernumber = | [aal [
Quantity Ordere ‘.OQ > [nore | Customernumber |- xfss] I

Comments

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Note: For information about adding parameters in the Query Editor, see Assigning Parameters in the MQL
| Query Editor.

Note: Click Preview at any time to view the data associated with your query.

6. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

7. Click OK in the Query Editor when you are done.
The Chart Designer appears.
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8. Under Data, click the drop-down arrow to display and select the table columns.

~ Data

Series Column:
Customernumber
Category Column:
Status

Values Column:
Total

Data Definition

Description

Series Column

Series show up as the individual columns on a bar chart
and as individual lines in a line chart. Area charts display
each series as a point.

Category Column

Categories are displayed as bars or groups of bars on
the x-axis (horizontal axis). In line charts, categories are
usually associated with time periods. In area charts, the
x-axis displays the category labels.

Note: If you don't want to display categories,
| select None.

Values Column

The value is always numeric. The value determines the
height of columns in a bar chart and the height of lines in
a line chart. In area charts, the y-axis values determine
the heights of the points.

\alues are the metrics (numbers) being graphed
Categories are labels describing a number
Series represent related groupings of Category-Value pairs

Values

Revenue Trend Summary

Categories

A preview of the chart appears in a box in the upper-right corner of the Chart Designer as you select your options.

9. Under Chart Type, click on a chart type to select it.

Note: By default, pie and dial charts display in "animated” Flash mode. You can turn animation off by
| disabling the Animated check box in the Chart Designer. Animated charts bring focus to important aspects
of your data. For example, animation allows you to bring out a data point if it reaches a critical value, such as

high or low sales numbers.

If you selected a pie or dial chart, see Working with Pie Charts or Working with Dial Charts, respectively.

10.Under Theme, select a theme from the list.
The theme is applied to your chart.

11.Enter the labels for the Chart Title, X Axis Title (horizontal axis), and Y Axis Title (vertical axis).

Entries are displayed in the chart preview.
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12.Click Apply to see the chart preview.
13.Click OK display your chart in the dashboard panel.

Working with Pie Charts

A pie chart gives dashboard consumers an immediate visual clue of the relative sizes of the shares of a whole.
Categories are represented by individual slices. The size of the slice in a pie chart is determined by the value.

Customers 144 and 145
143

145,041.6 of 220,795.48

/ Series
144

You can animate a pie chart if you want its pieces to be exploded, which means that the individual slices of the pie can
be pulled away from the rest of the pie.
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Trucks and Buses =

Wintage Cars

To animate a pie, enable Animated check box in the Chart Designer.

Working with Dial Charts

For dial charts to display correctly, you must enter values for your range and the chart title. In the example below, the
dial chart preview is displaying ranges associated with sales. Notice that each dial sector is represented by a color, red,
yellow, or green. The needle is positioned in the 220796.48 range, indicating that total orders, while not stellar, are not
near the danger zone indicated by the red sector in the dial.

Chart Designer

— Chart Type —————— Display
Type: Total Orders for Customers 144 and 145
@ Dial Chan -

Theme:
WijPrimaries
™ Animated

— Data

Series Column:

Category Column:

Values Column: Chart Title: Label Rotation (X Axis):
Total [Total Orders for Customers 144 and 145 |None ;l

Scale: X Axis Title: ( Range

[ e
& [100000 [150000 [280000

|-None-- | |
Y Axis Title:
Editquery | || |

Changing Dial Sector Colors

You can change the color of a dial sector by clicking the small down arrow in the color boxes associated with Range.
Select a color from the palette so that you can preview it on your dial chart. Click Apply to preview your dial chart. Click
OK to place your dial chart into the dashboard.
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Correcting Scaling Issues

Use the scaling feature in instances where numeric values in a chart are so long that they affect the display.

1. Preview your chart in the Chart Designer.

2. Under Scale, click to display the drop-down list of scaling options. In the example below, the scaling option used is
"1000." Notice the change in the display of numeric values when scaling is applied. Users of the chart can see actual
values when they hover over the bars in the chart.
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3. Click OK to display the chart in the dashboard.

Note: The scaling feature is available for all chart types except pie.

Rotating Chart Axis Labels

If your chart axis labels become unreadable because they are too long, Label Rotation may correct the problem.

1. In the Chart Designer, display your chart.

2. Under Label Rotation, select Diagonal or Vertical and click Apply.
The labels display with the rotation you set.

3. Click OK to display the chart in the dashboard panel.

Editing a Chart

Follow the instructions below to edit a chart.

1. In the Dashboard Designer, select the panel that is displaying the chart you want to edit.

2.
In the upper right corner of the panel click H’?(Edit)

The Chart Designer appears.

3. Click Edit Query.
The Query Editor opens.

4. Edit the query as needed and click OK.
The Chart Designer appears.

5. Select the appropriate data definitions to build the chart.
6. If applicable, change the chart type and theme and click Apply to see a preview of the edited chart.
7. Click OK to display the chart in the dashboard.

Adding a Data Table to a Dashboard

The Data Table feature allows you to display a tabular representation of a database query in a dashboard. It also allows
you and consumers of the dashboard to manipulate the display of the data in the data table, while in the dashboard. For
example, users can resize, sort, and change the order of columns. Follow the instructions below to add a data table to
your dashboard.

1. Select a panel in the Dashboard Designer.

2. Click = (Insert) and select Data Table.
The Select a Data Source dialog box appears.

3. Select a data source from the list of available data sources and click OK.
The Query Editor opens.
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4. Begin building your query. Click (+) next to the category name to display its associated table columns. When the
column names appear, click to select the column that contains the data you want displayed in your data table.

5. Click the small yellow arrow to place the column name under Selected Columns.

6. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions.

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Note: Click Preview at any time to view the data associated with your query.

7. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

8. Click OK in the Query Editor when you are done.
The Data Table appears in the dashboard panel.

Note: For more information about adding parameters in the Query Editor, see Adding Parameters to Your
Query Using the Query Editor.

You can edit the data table display directly in the dashboard panel.

Sorting Column Data

To change the sort order data under a column, click the drop-down arrow in the header and choose Sort Ascending or
Sort Descending. You can also hide one or more columns by disabling the appropriate check boxes next to the column
names.

------------------------------------------------------------------
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Adjusting Column Width

You can adjust the width of a column by clicking the right border of the column header and dragging it to the right or left.
Release the mouse button when you are done.
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Moving Columns

To move the placement of a column, click and drag the column it to the appropriate location in the Data Table as shown
in the example below:
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Paginating

The pagination feature allows you to page through a large number of records.
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Displaying a Report Designer File in the Dashboard

Follow the instructions below to display a report created in Report Designer and in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click = (Insert) and select File.
A browser window opens.

3. Locate the appropriate report file.

4. Click Select to place the report inside the dashboard panel.
Pagination control arrows at the top of a report allows you to scroll through long reports. Notice that the report file
name, NewReport.prpt, appears under Content: in the dashboard edit pane in the sample below. This sample report
contains parameters, (Additional Title-Text, Output Type), that do not have default values. You can enter values
manually and link them to a dashboard filter in the text boxes under Source. When the report renders again, the
parameter value(s) you entered are included in the report.
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Important: If you select a Report Designer file to place in a dashboard, but do not supply values for required
- parameters, the report will show up blank.

Displaying an .xaction File in the Dashboard
Follow the instructions below to display the contents of an .xaction file in a dashboard.

Note: Generally, .xaction files are provided to you by an administrator. An .xaction file may contain a report, a
@ chart, or other type of content.

1. Select a panel in the Dashboard Designer.

2. Click = (Insert) and select File.
A browser window opens.

3. Locate the appropriate .xaction file.
4. Click Select to place the contents of the file inside the dashboard panel.

Notice that the file name, Sales Year/Year, appears under Content: in the dashboard edit pane of the sample below.
This sample chart contains parameters, (screen_res, Region), and default values (large, NA).

Unbitied 1

3 a3p azp. Total Sales

£

Oty Tk
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% Genenal Settngs
" Firess Content:
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5. Save your dashboard. See Saving Your Dashboard for instructions.

Displaying an Analyzer Report in a Dashboard

Follow the instructions below to display an Analyzer report in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click - (Insert) and select File.
A browser window opens.

3. Locate the appropriate Analyzer report and click Select.
The Analyzer Report appears inside the dashboard panel.

4. Save your dashboard. See Saving Your Dashboard.

Displaying a Web site in a Dashboard

Follow the instructions below to display contents of a Web site in a dashboard panel. You may need administrator
privileges to display a Web site content in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click = (Insert) and select URL.
The Enter Web site dialog box appears.

3. Enter the Web site URL in the text box and click OK.
In the example below, a search parameter has been added to the URL.

%

T T

¥ Untitled 1 &
.

I Web Images Videop IMaps Mews Shopping Gmail more v
byronandmarina@gmail.com | [Geegle | My Account | Sign ou

Google

I Google Search || I'm Fealing Lucky srauscs Teel

The page at http://localhost:8080 says:

e Enter website address:

hittp: /fvawe.google.com//search?q=5{search}]

[ ok || cancel |

When the parameter displays in the edit pane of the dashboard, you can enter a value for the parameter in the text
box next to the parameter name.

Parameters:

Ha

search

4,
If applicable, click ﬁ (Edit) to make changes.
5. Save your dashboard when you are done.
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Filters allow you to display a subset of data based on the dashboard user's point of view. For example, the dashboard
user's point of view of Region may be "East;" his or her point of view of Time may be, "Fourth Quarter." Pentaho
Dashboards allows you to designate a point of view based on the filters in your source data.

Note: To ensure that a filter links to the correct content in a dashboard, the content to which you are linking
| (data table or chart) must contain at least one parameter. See Adding Parameters to a Chart or Data Table
Using the Query Editor for more information.

The parameter features available in dashboards do not apply to action sequences, Report Designer reports
(-prpt), and Analyzer reports. Parameters must be defined within the tools themselves. See Creating Content
to Content Links in an Analyzer Report, Linking an Action Sequence Parameter to Content in other Dashboard
Panels, and Allowing a Report Designer (.prpt) Hyperlink to Drive a Parameter in Another Dashboard Panel, for
more information.

Below are general instructions below for adding filters to your dashboard:

1. In the dashboard page, under General Settings, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

Click "' (Add) to start adding filters.
The Filter Properties dialog box appears.

4. In the Filter Properties dialog box, type a display name for the control label. For example, "Region."

5. Enable Display Name as Control Label if you want users to see the display name in the filter toolbar.

6. Select your control type. Control types define how your filter values are selected; for example, in a drop down list,
radio button, checkbox, and so on.

The table below contains a description of each control type.

Control Type Description

Drop Down Users select a filter value from a drop-down list.

List Users select a filter value from a scrolling list. This filter
control supports multiple selections.

Radio button Users click a radio button to select a filter value.

Checkbox Users enable a checkbox to select a filter value. This
filter control supports multiple selections.

Button User click a button to select a filter value. This filter
control supports multiple selections.

Text Field Users enter a text string or number into a text field
manually.

Date Picker Users examine filter values based on calendar date.

7. If you plan to provide hard-coded names and values for your dashboard users, see Creating a Static List of Filters. If
you plan to provide a dynamic list of filters based on a SQL query, see Creating a SQL List of Filters.

You must have a data table or chart that contains at least one parameter for your filter control to function correctly. See
Adding Parameters to a Chart or Data Table Using the Query Editor for more information.

When you create a static list, you define a static list of options to present to the dashboard user. Each option consists of
a display name that appears in a drop-down list and a value that is used to restrict the data query in the filter toolbar as
shown in the example below:
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Follow the instructions below to create a static list:

1. In the dashboard page, under General Settings, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

L
Click " (Add) to add a filter.
The Filter Properties dialog box appears.

Click on an icon to select your Filter Control type. In the example above, the .|:I. (Drop Down) control was used.
5. Ensure that Static List is selected under Type. Static List is the default selection.

T
Click & (Add).
The List Value dialog box appears.

7. Inthe List Value dialog box, enter the label and a value for the first option in the list. The label is the option that is
visible to dashboard users; the value is passed as the parameter's source value.

8. When you are done adding labels and values, click Close to exit the List Value dialog box.

9. In the Filter Control dialog box, change the label (filter option) that will appear first in the filter control selecting
another label from the list under Initially Selected.

10.In the dashboard, select your chart or data table. Click the Parameters tab and choose another Source for the
parameter from the list. That source should be the name of your filter control; in this example, Select Territory.
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The original default value (Source) for the {Territory} parameter was NA but for the filter to display correctly, the

Source was changed to Select Territory in the dashboard so that the filter control could drive the content in the
data table.

11.Click OK to exit the Filter Control dialog box.
The filter options are displayed to the dashboard user when viewing the data table.
12.Click OK to exit the Filter Properties dialog box and save your dashboard.

Creating a SQL List

You must have a data table or chart that contains at least one parameter for your filter control to function correctly. See
Adding Parameters to a Chart or Data Table Using the Query Editor for more information.

When you create an SQL List, you are using a SQL query to dynamically retrieve a list of display nhames and
corresponding values directly from a relational database as shown in the example below:

Filter
Mame:
City [] Displwy name as control label
Contral
L‘_”l H 2 £l = +
3
Data Control Properties
Type: Radio Buttons
[soL Lst | || mitiaty selected:
Con : Bnzbans
[sampeData ] Labes
Cpuery: & |CFI"r' l[
WAl
jm ~|
Dispiary:
Horzontal ~l
(EORA ) b Filters %

City

T
\M 2 Chatswood @ Glan Waverly O Melbourne O North Sydney O South Brisbane

Note: You must have administrative permission to create SQL-based filters.
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Follow the instructions below to create a SQL List:

1. In the dashboard page, under General Settings, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

Click "' (Add) to add a filter.
The Filter Properties dialog box appears.

In the Filter Properties dialog box, enter a Name for your filter.

Enable the Display Name as Control Label, if appropriate.

Click the appropriate icon to select your filter control. In the example above, the Radio Button control was selected.
Under Type, select SQL List.

Select the data source (Connection) that contains the content you need to set options from the drop-down list.

© © N o s

Click j (Edit) to display the Query input text box.
10.Type the SQL query in the area provided for you. If you enter a parameter query, use the following format
${parametername} and provide a default value for the parameter.

11.Click Test to ensure that your SQL query is displaying the correct values.

Note: Use a SQL query that returns two columns — one for the display name and one for the value.

12.Adjust your SQL query as needed and click OK.

13.Under Control Properties, enter a Default Label/Value for the initially selected option in your filter control.
14.Select a Label to display in the filter control; this is the user-friendly name that users will see in the dashboard.
15.Select the Value; this is the field that is passed as the parameter's source value.

16.1f applicable, select your Display type from the list.

Note: Some filter controls allow you to choose the position of your filter options. If you have a long list of
options, for example, a list of cities, you can change the Display type to horizontal.

17.Click OK.

The list of values appear in the filter toolbar in the dashboard.

You must have a data table or chart that contains at least one parameter for your filter control to function correctly. See
Adding Parameters to a Chart or Data Table Using the Query Editor for more information.

When you create a Metadata List, you are defining a query to retrieve a list of display hames and corresponding values
from a metadata data source provided by your administrator.
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. In the dashboard page, under General Settings, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

" Click ﬂ (Add) to add a filter.
The Filter Properties dialog box appears.

. Inthe Filter Properties dialog box, enter a Name for your filter.
. Under Data Type, select Metadata List.

. Click Select to choose the data source that contains the content you need to set options from the drop-down list and
click OK.
The Query Editor opens.

. In the Query Editor, build a query to select either a single column (that represents both a name and a value), or two
columns representing the display hames and corresponding values.

Note: If a single column query is defined the values of that column will be used for both the display names
and the values.

. Click OK to exit the Query Editor.
Your options appear under Selected Items in the Filter Properties dialog box.

. Under Control Properties, enter a Default Label/Value for the initially selected option in your filter control.
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10.Select a Label to display in the filter control; this is the user-friendly name that users will see in the dashboard.
11.Select the Value; this is the value in the database that is associated with the Label you selected in the previous step.
12.1f applicable, select your Display type from the list.

Note: Some filter controls allow you to choose the position of your filter options. If you have a long list of

options, for example, a list of cities, options may not appear correctly in the user console unless you change
the Display type to Horizontal.

13.Click OK.
The list of values appear in the filter toolbar in the dashboard.

Creating a Cascading Filter

A cascading filter changes based on a value a user selects. When the value in the drop down list, (Country), changes,
the filter is automatically applied to the second filter, (City) thus changing its values.

[ Filters é',-—

Country City rF

LISA [ aiientown [ soston [ erickhaven [ Bridgewater [ erishare [ surbank [ Burlinga
Glendale [ Lasvegas [ Los angeles [#] wvC [ washus [ vaw pedford [ Hew Haven

The example above was created using a Metadata List for the drop down filter (Country).
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The Default Value for the selected_country parameter was set to USA with New York City (NYC) as the initially
selected value for the checkbox filter.
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select distinct city [Iom customers where COUNCIY =
Giselucted countiy}l

To link the City filter to the Country filter, another Source for the selected_country parameter was chosen. The
alternate source is the Country filter.

Once the filters are linked, users can select a country and then select a city (or cities) in the country of their choice.

Using this example, the report designer can now add a data table, chart, or other content in the dashboard that can be
driven by the filter he or she just created. Suppose the designer decides to add a pie chart to the dashboard. The pie
chart will display the percentage of sales per city.

In the Query Editor, the report designer creates a parameter, {City}, with an extended default value: NYC|Las Vegas.
The resulting pie chart displays values for New York City and Las Vegas. Under the Parameters tab associated with the
pie chart, the Source value for the City parameter is changed to the City filter.
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When the report is saved, users of the dashboard can see results for a country and multiple cities within that country.

[r Filters
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Fercentage by City

Editing Filters
You can edit filters as needed. Follow the instructions below to edit filters:
1. In the dashboard page, select an existing dashboard.

2. Under Objects, click Filters to display the filters associated with the dashboard you selected.

3.
Select the filter you want to edit and click ﬁ

The Filter Properties dialog box appears.
4. Make your changes as needed and click OK to update the filter-related options in the dashboard.

Linking Dashboard Filters to Analyzer Parameters

This process only applies to dashboards that include parameterized Analyzer reports. You must have an Analyzer
report with a query parameter in it in order to proceed.

The instructions below explain how to parameterize an Analyzer report to a dashboard in Dashboard Designer.

1. In Analyzer, select a field in your report to which you want to link; then, right-click and choose Filter.

In the example below, data will be filtered by Territory.
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In the Filter dialog box, enter a name for the parameter in the Parameter Name text box and click the check box to

enable it.

Showing Bl 5 values

TERRITORY_PARAM

Parameter Name

. Select the values you want associated with the parameter. Use the arrows to add values to the box on the right.
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. Click OK to exit the Filter dialog box.
. Save your Analyzer report.

In the upper left corner of the report, you can see that a filter is in use. Click -‘ﬁ (Edit) to edit your filter; click E to
delete the filter.
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6. Create a dashboard and drag the Analyzer report into a panel.

The name of the parameter appears in the lower portion of the dashboard under Parameters.

7. Add a filter to the dashboard based on the parameter you created in your Analyzer report.
The filter appears in the dashboard.

Working with Parameters

If you are placing a file, such as an .xaction or .prpt, inside a dashboard panel, it is possible that the author of the

file, defined meaningful parameters for the content. If previously defined, the parameters and their associated default
values, appear under Parameters in the edit pane of the dashboard. In the example below, when the chart initially
rendered, it displayed a parameter called, "chart_type" with a default value called, "bar." A user can change the value of
the parameter to see the content rendered as a pie, line, or area chart.

Chart Pick List

BAR CHART
Product Line Sales
Year to Year

1,750,000 (%) | Fasamnatan
Nasna
1,500,000 (%) 1
chart_type
1,250,000 ($) 1
1,000,000 (%) 1
750,000 () { |
500,000 (8) { I l l l
| 1 ™ m
>

S et

]
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Chart Pick List &),

Ll

Line Chart
Product Line Sales

Year to Year
1,750,000 (§) 1
1,500,000 () {
1,250,000 (§) 1
1,000,000 ($) 1
750,000 (%) 4

500,000 (8) |

Parameter names are "hard-coded," in the file; that means they cannot be changed. Neither can you change the
number of parameters associated with a file. When you create a chart using the Chart Designer, embed a URL into a
dashboard, or create a data table, you can change both the name and value of a parameter.
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Adding Parameters to a Chart or Data Table Using the Query Editor

When you place a chart in a dashboard panel, you use the Query Editor to retrieve data from a database for display on
your chart or data table. If applicable, you can add Conditions or constraints that filter the data so that the chart or data
table displays the information you want dashboard consumers to see.

Using parameters is critical if you plan on using dashboard filters or linking content in one dashboard panel to content
on another dashboard panel. For example, suppose you create a pie chart and you want to filter details associated
with an exploded pie slice in the adjoining data table as shown in the example below. In this instance, you must use a
parameter that allows the data table to update when a dashboard consumer clicks on a pie slice. Optionally, you can
parameterize the query condition so that the content is updated based on a user interaction, such as changing a filter
value.

Territaries .Detuilﬁ Data Table

Terrilnny Coundry Product Line Tokal (SUM

EREL France Classic Cars IBE0S1.2

ENEL Franze Wabareycies 22838031

P EMEL France ‘ntage Cars TE608.81

5,008,224.36 of 10,645,949 15] EMEA France Flarss 108158 58

- I EMEA France Ships BE4BE BT

L ﬂ‘ EMEA France Trucks and Buses 11668222
Page 1 of4 | b M Displaying 1 - 20 of 79

To create a parameter, in the Value field, type the name of the parameter inside curly braces, as in {Parameter
Name}. In the example below, the designer created a parameter called, {TERRITORY}; the default value, or source,
for the parameter is, "NA" (North America). When a chart or data table renders, it displays data associated with North
America. Remember that this a default value. When you enclose a parameter name with curly braces, you are creating
a parameter query. That means, that users can change the query dynamically by replacing the default, "NA," with a
different territory acronym, (for example, EMEA), when the query runs.

Conditions: v a g}
Combine Aggregation (Column Comparison Value Default‘,
| nonE  w| Terrtory exactly matches | (TERRITORY} NA %

2

You can define two defaults by adding a pipe (]) between the values, as in NA|[EMEA.

Suppose a dashboard designer chooses to limit the data to North America (NA) exclusively? In this instance, he or she
would not include the curly braces around "NA," (as shown in the example below), and Default (value) is disabled. This
is an example of a static query.

Conditions: v &

E
ine  |Aggregation |Column Comparison Value Default }"
o v | RemeeR I ety matches v A !

MWM

Using Content Linking to Create Interactive Dashboards

Depending on your needs, you can create a "static" dashboard, which contains content in each panel that is separate
but related. For example, you may provide users with a bar chart that contains total sales figures by region. Additionally,
you may provide a data table that displays sales details for each state in a specific region. You may also want to provide
sales data associated with each salesperson in a specific region. The content in your dashboard is useful to dashboard
consumers, but to make it more "interactive," you may want to consider using content linking.
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The content linking features in dashboards allow you to associate (link) content in one dashboard panel to content on
another dashboard panel as long as query parameters have been defined. These features are particularly helpful for
drilling down or for dynamic filtering; for example, when dashboard consumers explode a single slice in a pie chart to
launch content in a data table associated with that pie slice. In this instance, dashboard consumers are moving from a
summary view to a detailed view interactively.

You can use content linking if your dashboard panel contains a data table, chart, .xaction, .prpt, and Analyzer report.

Content Linking and Query Parameters

Query parameters are required for content inside a dashboard panel to receive values used to filter data from a filter
control. They are also required when receiving values from content in other dashboard panels that are broadcasting
values associated with Content Linking. The way in which query parameters are defined is different depending on the
type of content you are placing inside your dashboard panels:

If Then

You are defining parameters in the Analyzer... See Adding Query Parameters to Analyzer Reports

You are defining parameters in an Action Sequence Refer to the section, "Content Linking in Dashboards," in

(.xaction)... the Creating Action Sequences guide available from the
Pentaho Knowledge Base.

You are defining parameters for a chart or data table... Use the Query Editor to define your parameterized query.
See Linking Charts and Data Tables and Linking Columns
in a Data Table to Content in other Dashboard Panels

Below are general instructions for linking charts and data tables in a dashboard. This is just an example. You must
adjust the instructions when working with your own data.

1. Create a simple dashboard that contains a chart and a data table. At this point, none of the content has been linked
and you have a "static" dashboard.

<= Fiters
Orders Pie Chart COrder Detais

Termiorny Couniry

Notice the pie chart in the example above. You want dashboard consumers to click a slice (NA, APAC, Japan,
EMEA) and have the data table on the right update with the values associated with that slice exclusively. For
example, if a report consumer clicks the EMEA slice, the data table will display values associated with EMEA and
nothing else. To get the correct filter display, you must first create a parameterized query that drives the content in
the data table.

2. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in
the Valuetext box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called TERRITORY with a default value of NA has been created.

Note: Parameterizing a query, as described here, allows you to pass values dynamically and update the
| chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.
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In the Pentaho User Console, click the data table and examine its available parameters. In the example below, there
is an available parameter called TERRITORY with a default source value of NA (North America). There are no more
other sources that control the TERRITORY parameter.

T
]
Dbjects T TRk ’},
?Ejl Gereral Settings Oz Cooren Taizhe i SOUCE
I Fiears Rebrnsh Troeral (] L L
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3. To enable content linking, select the chart. Click the Content Linking tab then click the check box next to the field
name you want enabled for content linking. Click Apply.

Thtis: ;

Cirdars B Char | Parameters | Content Linking >

Rafrash Irbarval (ssc) JEagpled Fiekd 2

o ' | I
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Cordunt: \\

Chart 3
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This step enables content linking on the chart series; in this example, the chart series is Territory. When you enable
content linking on a chart series, you make the series value available as a source of parameters for content in other
dashboard panels.

4. Click the data table to display the available parameter, then click the down arrow, (in the Source text box), to display
a new source for the parameter. Select the new source. In the example below, the new source is Orders Pie Chart -
Territory. Click Apply.

[ Parametersx[mntenl L'I'Ifl'lgﬁ
kB |source

[ ~]

}um Pie Chart - Territory
R i ~f

.

The new source for the parameter corresponds to the title of the dashboard panel that contains the chart as shown
in the example above. This new source will now drive the display in the data table.

5. Save your dashboard. See Saving Your Dashboard.

When users click a pie slice or bar in a chart, the data table displays content associated with that specific pie slice or
bar.

Linking Columns in a Data Table to Content in other Dashboard Panels

The instructions that follow show you how to link a chart to a column in a data table. You must adjust the instructions
when working with your own data.
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1. Create a simple dashboard that contains a data table and a bar chart. At this point, none of the content has been
linked and you have a "static" dashboard.

Order Detais :
Termitory Couriry Proguct Line: Total (SUM}
M& Uza ;"mtage Cars ] T5T755.9
Tl USa Clasaic Cars 13446382
Ha, usa Trucks and Buses IeTRa2 42
& UEs Motorcycies s203T.7
M usa Traing E8253.58
T, Usa Shioe 2056568, 14
s U5s Planes 2e42252
&, Canada Classic Cars E1E23.22
Hs Canada Trucks and Buses 515945 58

€]

Displayirg 1 - 130

g
Product Line Sales by Termitery o~

3,400,000, oosic Cars

Z.000.0004

1,600,0004

1,200,0004

B00,0004

400,000
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Notice the data table in the example above. You want dashboard consumers to click on a product in the Product
Line column and have the bar chart update with information about sales by territory for that specific product line.

2. Add a parameterized condition to the query for the bar chart by specifying a parameter name in curly braces in the
Value text box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called Productline with a default value of Classic Cars has been created.

Query Editor
Categories / Columns Selected Columns: v a
® Customer Aggregation |Cnlumn
& Orders NONE ﬂh i

= NoNE | Product Line
# Products :

SUM | Total

@ Payments g

ey 0o
Conditions:

. Ine Aggregation
~|nonE || Product Line

|exav:li5r matches il .lPrndu:ﬂine} “l’_‘.lnssic Cars

3. Inthe Chart Designer, set the data definitions for the series, category and values columns associated with your bar
chart and click OK.
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4. Under General Settings, select the data table and click the Content Linking tab. Enable content linking on
the column in your data table that will filter content in your chart. Each of the columns in a data table are able to
broadcast values to other dashboard components.

=
| rier Detais | | Content Linking |
Rfrash Intarva (sec) |Fieid

Tarriery

Tt [SUM]

5. Under General Settings, select the chart and click the Parameters tab. Click the down arrow, in the Source text
box to display another source for the parameter you created. In the example below, notice that Order Details -
Product Line , (this is the name of the dashboard panel that contains the data table), can now be selected as a
source for the Productline parameter.

6. Save your dashboard. See Saving Your Dashboard for instructions.

7. In the data table, select an item in the column that has content linking enabled.
The content in the chart updates in response to the item that was clicked in the data table.

In the example below, the Product Line column was enabled for content linking.

Order Detals
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Pentaho Bl Suite Official Documentation | Displaying Data in a Dashboard | 57



Creating Content to Content Links in an Analyzer Report

Below are general instructions for creating content links in an Analyzer report, (inside a dashboard), that can be used
to drive the parameter values of content in other dashboard panels. You must adjust the instructions when working with

your own data.

1. Create a simple dashboard that contains an Analyzer Report and a data table. At this point, none of the content has
been linked and you have a "static" dashboard.
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In the example above, when content linking is achieved, the list of territories (APAC, EMEA, Japan, and NA) will
become hyperlinks that, when clicked, will update customer details data table. To get the correct filter display, a
parameterized query that drives the content in the data table must be created.

2. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in
the Valuetext box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called TERRITORY with a default value of NA has been created.

Note: Parameterizing a query, as described here, allows you to pass values dynamically and update the
| chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.

Conditions: v 2 g}
Combine  Aggregation Column Comparison Value Default |
| |noNE | Terrtory exactly matches | {TERRITORY} NA ‘}

mmaww

Under General Settings, click the data table and examine its available parameters. In the example below, there is
an available parameter called TERRITORY with a default source value of NA (North America). A drop-down arrow
in the Source text box indicates that there are additional values to control the available parameter. In this example,
there are no additional source values that control the TERRITORY parameter.
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3. Under General Settings, select the Analyzer report. Click the Content Linking tab then click the check box next to
the field/column name you want enabled for content linking. Click Apply.

Custormer Details

Refrash Interval (sac)

Titk: [ Parameters]| Content Linkng

Territory Sales by Product Line I
|Enabled |Feid |
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Content: {)
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In the Analyzer report, the values under the Territory become hyperlinks.

1
Terntory Sales by Product Line 3
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E
L
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L
i 52,615 j
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4. Under General Settings, select the data table and examine its available parameters. Notice that there is a drop-
down arrow in the Source text box. Click the down arrow to display and select a new source value for the available

parameter. Click Apply.
5. Save your dashboard. See Saving Your Dashboard.

In the example below, content linking was applied. When users click on a territory hyperlink in the Analyzer report, the
data table updates and displays customer-related details associated with that specific territory exclusively.
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Linking an Action Sequence Parameter to Content in other Dashboard Panels

Territory Sales by Praduct Line
fp Mo Filter in use " Your repart is ready. Rows:
Lina:
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To complete this task you must have an action sequence (.xaction) that contains at least one parameter. For
information about defining parameters in an action sequence see the Creating Action Sequences guide available in the
Knowledge Base.

Below are general instructions for allowing an Action Sequence parameter to drive the filter associated with content in
another dashboard panel. You must adjust the instructions when working with your own data.

1. Create a simple dashboard that contains an action sequence file and a data table. At this point, none of the content
has been linked and you have a "static" dashboard.
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Notice the chart (action sequence file) in the example above. You want dashboard consumers to click on a territory
(APAC, EMEA, etc.), bar and have the data table update with information about that territory specifically.

. Under General Settings, select the action sequence file and click Content Linking. If parameters have been
defined in the action sequence, they will appear as values to be enabled for content linking. Parameters are hard-
coded in the action sequence and cannot be changed.
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. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in the
Valuetext box; then, provide a default value for that parameter in the Default text box.

Note: Parameterizing a query, as described here, allows you to pass values dynamically and update the
chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.

.

Under General Settings, click the data table and examine its available parameters. In the example below, there is
an available parameter called TERRITORY with a default source value of EMEA. A drop-down arrow in the Source
text box indicates that there is an additional value to control the available parameter. The value comes from the
parameter in the action sequence.
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4. Save your dashboard. See Saving Your Dashboard.

5.

In the action sequence file click on an object such as a bar as shown in the example above.

The content in the data table updates in response to the object that was clicked in the action sequence.

Controlling a Dashboard Parameter From a PRPT Hyperlink

You must have a report (.prpt) that contains a hyperlink before you can complete this task. See the Report Designer
User Guide, (available in the Pentaho Knowledge Base), for instructions about adding hyperlinks to a report.

The instructions that follow show you how a link inside a Report Designer report (.prpt) can drive a parameter in content
on another dashboard panel. You must adjust the instructions when working with your own data.

1. Create a simple dashboard that contains a .prpt report and a data table. At this point, none of the content has been
linked and you have a "static" dashboard.
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Notice the report (.prpt) in the example above. You want dashboard consumers to click on a territory (APAC, EMEA,
etc.), hyperlink and have the data table update with information about that territory specifically.

2. Under General Settings, select the report (.prpt) and click the Content Linking tab. Click the checkbox next to the
field you want used for content linking.

3. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in
the Valuetext box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called TERRITORY with a default value of NA has been created.

Conditions: v a ;}
\Combine  |Aggregation |Column |Comparison Value Default ;
| noNE | Terrtory exactly matches | {TERRITORY} MA ‘}

.

Note: Parameterizing a query, as described here, allows you to pass values dynamically and update the
| data table based on events triggered by other elements of the dashboard such as a user selecting an item
from a filter control or following links defined in content associated with another panel in the dashboard.

4. Under General Settings, select the data table and click the Content Linking tab. Click the drop-down arrow, in
the Source text box to display another source for the parameter you created. In the example below, notice that
Product Line Share by Territory - Territory , (this is the name of the dashboard panel that contains the .prpt), is
now selected as a source for the Territory parameter.

O T Y A v

Titlg: Pararnatars .-Cmu“: Linking |

Cusiomer Zales by Ternéory

Name SOurce

Rafrash Interval (sec)
Tefrkary Product Line Share by Terridory - Temriory

Caortent:
Data Table

et el

4

Y W I R . e W T

5. Save your dashboard. See Saving Your Dashboard.
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When content linking is achieved, the data table updates when a link in the report (.prpt) is clicked as shown in the
example below.

Froduct Line Share by Tarritory
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Saving Your Dashboard

Follow the instructions below to save your dashboard:

1.

2.
3.

4,

In the Pentaho User Console toolbar, click E (Save) to open the Save dialog box.
In the File Name text box, type a file name for your dashboard.

Enter the path to the location where you want to save your dashboard. Alternatively, use the up/down arrows or click
Browse to locate the solution (content files) directory in which you will save your dashboard.

Click Save. See Editing Your Dashboard.

Editing Your Dashboard

Follow the instructions below to edit an existing dashboard:

1.

In the lower left corner of the Pentaho User Console, (under Files), select an existing dashboard file.
The dashboard panels and their related content appear.

]
Click | (Edit) from the console toolbar to go into Edit mode.

Click ﬁ (Edit) in the upper-right corner of the dashboard panel you want to edit.

Note: Some content such as action sequence files (.xaction) and Report Designer files (.prpt) cannot be

edited directly in the dashboard. In such instances, -j (Edit) is disabled.
Make your changes as needed.

I
In the toolbar, click B(Save As) to open the Save As dialog box.
In the File Name text box, type a file name for your dashboard. Alternatively, use the up/down arrows or click
Browse to locate the solution (content files) directory in which you will save your dashboard.

Click Save.
The name of your dashboard file appears in the list under Files in the lower left portion of the Pentaho User

Console.
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Follow the instructions below to add an existing chart, table, or file to your dashboard panels using the drag-and-drop
feature.

1. Create a new dashboard. See Creating a New Dashboard for specific instructions.

2. In the left pane of the Pentaho User Console, under Files, locate to the content (chart, table, or file) you want added
to your dashboard.

3. Click and drag the content into a blank panel on your dashboard. You will see the "title" of the content as you move it
around the dashboard. Notice that the title background is red; it turns green when you find a panel where the content
can be dropped.

Repeat steps 2 and 3 until your dashboard contains all the content you want to display. To swap content from one
panel to another, click the title bar of the panel that contains the content you want moved and drag it over the panel
you want swapped. You will see the swap icon as you are moving the content.

If you are working with an existing dashboard, you can perform steps 2 and 3 steps; however, a warning message
appears when you try to place content in a panel that already contains content. The new content will override the
existing content.

4. Save your dashboard.

Sometimes you must adjust the whitespace in dashboard panels, (or the filter panel), so that content appears correctly.
Follow the instructions below to adjust whitespace.

1. Open an existing dashboard.
2. In the lower pane, click General Settings and then click the Properties tab.

3. Click Resize Panels.
The whitespace between the dashboard panels turns blue.

4. Adjust the panel size by clicking and holding the left mouse button down as you move the blue lines (whitespace)
around. Release the mouse button when you are satisfied with the positioning of the panel.

& 2| Untitled 2

qu,r~J Jh\‘"'up""huzm

/ \"\ﬂ/wwwwwj

5. Click Close in the lower right corner of the dashboard to exit resize layout mode.

6. Examine the dashboard contents to make sure they are placed correctly. You can return to the resize layout mode if
you need to make additional changes.

7. Save your dashboard.
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Setting the Refresh Interval

The content in your dashboard may need to be refreshed periodically if users are examining real-time data. You can set
refresh intervals for individual panels on your dashboard or for the entire dashboard.

To set the refresh interval for individual panels in the dashboard, select the panel that contains the content you want
refreshed. Under Refresh Interval (sec) enter the interval time in seconds and click Apply.
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" Untitled 1

Title
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120

If you want the entire dashboard to refresh, click the Properties tab in the dashboard and set your refresh interval.
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The Pentaho User Console has the ability to run reports at specified intervals, even if user input is required to properly
execute the report. The sections that follow explain how to set up and configure private schedules. Private schedules
are ad hoc, non-subscription schedules; subscription schedules, also referred to as public schedules are set up by an
administrator. You must have proper permissions to set up a private schedule.

For more information about schedules, see the demo, Scheduling, Subscription and Distribution, on the Pentaho Pre-
Sales Sandbox.

You can configure the Pentaho Bl Server to run reports at regular intervals, or on certain dates and times. Follow the
instructions below to create a private schedule.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to schedule, then click Schedule in the context menu.
The New Schedule window appears.

3. Type in a name to identify the schedule by in the Name field, and a group name (for groups of schedules) in the
Group field. Optionally you can also enter a description of the schedule in the Description field.

4. Select an interval from the Recurrence drop-down box. If you would like to enter a custom interval, select Cron and
consult the Quartz reference to learn the Quartz syntax.

5. Adjust the interval settings accordingly; these settings should be self-explanatory.
6. Click OK to complete the schedule.

The report is scheduled to execute at the interval you specified. It will also be listed in My Workspace.

The Quartz cron engine supports a seven-attribute time declaration with many possible values. The number format is
the same for every expression, even if the values are different -- it must be listed as seconds, minutes, hours, day of
month, month, day of week, then the year. A space separates each attribute.

Possible values for each attribute should be mostly obvious -- 0 to 59 for seconds and minutes, 0 to 23 for hours, 1

to 31 for days, 1 to 12 for months, 1 to 7 for day of week, and a four-digit year. Alternatively you can use three-letter
values for the day of week (MON, TUE, WED, THU, FRI, SAT, SUN), and three-letter values for the month (JAN, FEB,
MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC).

An asterisk (*) indicates all values, so an asterisk in the minute field would mean that the report runs once every minute.
You can specify a range of values with the - (dash) operator, and you can specify multiple individual values with a
comma. If you need to excuse a value in the day of month and day of week field from a cron job, you can use the
question mark (?) character to indicate that this value doesn't matter. If you need to split values, you can do so with the
slash (/) character -- this operator literally means "every," so */15 would mean "Every 15." In the day of month field, you
can use the # character to indicate a certain instance of a day of the month, for instance the second Friday of the month
would be 6#2. Lastly, you can use a capital L in the day of month and day of week field to indicate "Last," as in the last
day of the week. A capital C in either of these fields means "Calendar," and combined with a number means that the
report should execute a the interval indicated by the C number according to the loaded calendar. A capital W in the day
of month attribute means "Weekday," which only encompasses Monday through Friday. Most of these values can be
combined to create unusual cron schedules.

Attribute Conditionals and Operators
Seconds A
Minutes - x
Hours N
Day of month ,-*¥?2/LWC
Month ,-*
Day of week ,-*?2I/LC#H#
Year A
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Execute a report at 10:15 AM on every last friday of every month during the years 2008, 2009, and
2010:

0 15 10 ? * 6L 2008-2010

Once you've scheduled a report, you can easily delete the schedule without deleting the report. You must have
administrative privileges to delete a schedule.

Note: To reliably delete a schedule, suspend the schedule first then delete it from your workspace. After the
| delete process completes, you may restart the schedule.

1. Click the My Workspace button, which is the second one in from the right side of the toolbar.
2. Click the triangle next to the Waiting section to see a list of scheduled reports.
3. Click Cancel next to the schedules you'd like to delete.

The previously scheduled report will no longer run at the specified interval.

By default, reports created with Report Designer and published to the Bl Server will have their data sets cached to
improve performance. If you are working with a volatile data source and will be regenerating reports frequently, you
may need to manually flush the report cache, which will force the Reporting engine to recalculate the result sets for all

reports.

To do this, log into the Pentaho User Console as an administrator user, then go to the Tools menu, select the Refresh
sub-menu, and click the Reporting Data Cache item.
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Below are problems that have been discovered by other Pentaho User Console users and testers, and solutions for
addressing them.

Internet Explorer 8 can't preview CSV/PDF/XLS ad hoc report content

Internet Explorer 8 has extra security features that prevent users from downloading content files generated by the ad
hoc reporting interface. In order to work around this, you must force IE8 to recognize the Bl Server host as an intranet

zZone.

To do this, go to the Tools menu in Internet Explorer, then select Internet Options. In the ensuing options screen,
click the Security tab, then the Local Intranet icon. Click the Sites button. In the dialogue the follows, deselect the
Automatically detect intranet network option, then click OK to close this window, then OK again to close the Internet
Options window.
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